
Experiment 4 

 1

Chemistry 112 Laboratory 
Experiment 4:  An Exploration of Molecular Shapes: 

MacSpartan Pro and Molecular Models 
(This activity will be conducted in Olin-Rice 341) 

 
Introduction 
The three-dimensionality of a molecule is critically linked to its chemical and physical 
properties.  For example, the bent geometry of water causes its polarity.  The polarity of a 
molecule (or lack thereof) strongly influences its boiling point, freezing point, reactivity, and 
countless other properties.  The key biochemical interactions between an enzyme and a substrate 
rely on specific structural characteristics of each molecule.  A sound understanding of molecular 
shapes is necessary to fundamentally understand chemical and biological phenomena.  Chemists 
routinely predict the structural characteristics of proposed molecules when designing substances 
for specific applications.  The structure of a molecule is inherently linked to its function. 
 
Valence Shell Electron Pair Repulsion Theory (VSEPR) is a systematic methodology for linking 
a two-dimensional Lewis structure to a molecule’s three-dimensional shape.  The application of 
VSEPR permits the reliable prediction of molecular structure and bond angles.  This information 
can be used to subsequently determine other molecular properties (e.g., dipole moments).  
 
This experiment will provide an opportunity for you to use computational chemistry software to 
calculate and observe shapes of molecules.  Concurrent with your construction of molecules in 
MacSpartan Pro, we will ask you to build representations of molecules with a molecular model 
kit.  A successful study of chemistry requires that one be able to visualize molecules in three-
dimensional space using both hand-held models and via a computer screen.  We hope that you 
enjoy using the MacSpartan Pro software to gain a new perspective on VSEPR.  MacSpartan Pro 
is a “common thread” through our chemistry curriculum, as it is used in General Chemistry II, 
Organic, Physical, and Advanced Inorganic Chemistry courses at Macalester College.  
MacSpartan Pro is also a critical aspect of next week’s Chemistry 112 experiment, as we 
continue to explore chemical bonding. 
 
Ground Rules 
We encourage you to work in groups of two for this experiment.  However, please take turns at 
the mouse so that everyone gains a solid proficiency with MacSpartan Pro.  In addition, it is 
important that all students learn how to use the Molecular Visions® model kit.  All information 
documented in your laboratory notebook should be turned in as your report for this 
experiment.  Make sure that each table/answer is clearly labeled to help us follow your work. 
 
Drawing Molecules and Calculating Bond Angles with MacSpartan Pro: 
 

A Good Starting Point:  Identical Coordination and Steric Numbers 
 
The best way to start an investigation of VSEPR is to consider some fundamental molecular 
shapes that are free of distortions.  Let’s explore the molecule BF3 as our first example! 
 

• Design a laboratory notebook table to clearly present information with the following 
headings:  “Lewis Structure,”  “Coordination Number,” “Steric Number,” ”Shape Name,” 
and “Calculated Bond Angles.” 
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• Draw the Lewis structure of BF3.   
 
The following molecular geometries apply when the steric number equals the coordination 
number: 

Steric Number Shape 
2 Linear 
3 Trigonal pyramidal 
4 Tetrahedral 
5 Trigonal bipyramidal 
6 Octahedral 

 
• Record the “Shape Name” for BF3 in your laboratory notebook.  
 

To start MacSpartan Pro, click on the desktop icon labeled “Macintosh HD”.  Select “Chemistry 
Applications” from the left field of the window.  Choose the icon labeled “MacSpartan Pro 
Alias” from the applications that appear.  MacSpartan Pro may take a few moments to load. 
 
Will MacSpartan Pro predict the same structure for boron trifluoride?  Let’s find out! 
 

• Select New from the File menu.  The Model Kit window will appear.  This is your palette 
for drawing chemical species (atoms, molecules, ions, or even groups of molecules/ions). 

 
• Select the Expert tab. 

 
A common practice in computational chemistry, the study of molecular properties with computer 
software, is to begin with a structure that the chemist believes approximates the naturally 
occurring structure.  This makes for more efficient calculations as it saves computer time.  We’ll 
take this strategy (using VSEPR as our guide) with the molecules in this experiment. 
 

• Select the arrangement of electron pairs (with X as the central atom) that best matches 
your prediction for boron trifluoride. 

 
• Change the central atom to boron by clicking on Element and choosing Boron from the 

periodic table. 
 

• Click in the center of the drawing workspace to place a three-coordinate boron atom.  
Rotate the molecular fragment so that you can see all three “half-bonds” by clicking and 
dragging on the workspace background. 

 
Our next objective is to add the three fluorine atoms. 
 

• Select the Entry tab.  Select the fluorine atom icon. 
 
• Click on each “half-bond” of the boron atom to complete the three boron-fluorine bonds. 

 
Now we are ready to begin our computer calculation. 
 

• Select Save As under the File menu.  Save your Lewis structure with an appropriate 
name.  All structures must be saved before conducting calculations. 
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• Select Calculations from the Setup menu. 

 
• Setup the calculation to determine the “Equilibrium Geometry” with “Molecular 

Mechanics” and “MMFF” (Molecular Mechanics Force Field).  Start from the “Initial” 
geometry.  Deselect “symmetry”.  Click “OK”. 

 
•  Select Submit from the Setup menu to begin the calculation.  Select OK to 

acknowledge the beginning and the end of the calculation. 
 
The trigonal planar boron trifluoride molecule should be in the workspace.  In this case, the 
calculation should have verified that the entered geometry is the optimum structure for BF3.  We 
encourage you to rotate the molecule by clicking and dragging on the workspace.  Verify that the 
molecule is planar by viewing it from different perspectives.  Before we examine the bond angles 
of boron trifluoride, let’s play with our optimized molecule to learn more about MacSpartan Pro. 
 

• Enlarge/Reduce the Molecule:  Depress the option and apple keys simultaneously while 
dragging the mouse in the appropriate direction to achieve the desired effect. 

 
• Molecule Representation:  The way in which a molecule is displayed can be changed by 

switching between the “wire”, “ball and wire”, “tube”, “ball and spoke”, and “space 
filling” options under the Model menu.  Try out these different options for fun. 

 
• Move the Molecule:  Depress the mouse and option key simultaneously while moving the 

mouse. 
 

• Rotate the Molecule in the X/Y Plane:  Click on the background and drag the mouse in 
the desired direction. 

 
• Rotate the Molecule in the Z Plane:  Depress the mouse and apple key simultaneously 

while dragging the mouse in the desired direction. 
 

Now let’s examine the molecule in terms of its bond angles!  The shape of a molecule is defined 
by its bond angles.  
 

• From the Geometry menu, select Measure Angle. 
 

• Determine the three bond angles by sequentially clicking on each set of three atoms that 
define each molecular angle.  It is important to select boron as the second atom during the 
determination of each angle.  Each angle will be displayed in the lower right corner of the 
workspace.  Click on the workspace background to “deselect” each angle before finding 
the next one. 

 
• Record the calculated angles for boron trifluoride, a classic trigonal planar molecule, in 

your laboratory notebook. 
 
Our next goal is to determine bond angles for other chemicals with identical coordination and 
steric numbers. In this regard, we need to conduct calculations on linear, tetrahedral, trigonal 
bipyramidal, and octahedral molecules. 
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• Delete your BF3 molecule by selecting Clear from the Edit menu. 
 
• Conduct the same steps in your notebook (write the “Lewis Structure,”  “Coordination 

Number,” “Steric Number,” “Shape Name,” and “Calculated Bond Angles”)for the 
following molecules:  CO2, CH4, PF5, SF6.  (Note:  Students who enroll in Physical 
Chemistry I (CHEM 311) have the opportunity to study SF6 in the laboratory.) 

 
Useful Information (Ask for assistance with any of the molecules/calculations if necessary) 
 
1.  Use the Expert window for the complete construction of CO2.  Select carbon as the element.  
Choose the icon from the first two rows that represents the geometry about the carbon.  Click the 
central atom into the workspace.  Next, select the bond type (from the third row of icons) that 
matches the carbon-oxygen bonds of your Lewis structure.  Double click on each bond to change 
the bond type.  Finally, add the terminal oxygens from the Entry Model Kit. 
   
2.  For CH4, PF5 and SF6, use the Expert Model Kit window for the central atom and the Entry 
Model Kit window to add the outer atoms. 
 
3.  The tetrahedral icon is the first one in the second row of the Expert Model Kit window.  The 
trigonal bipyramidal icon is second from the left in the second row.  The octahedral icon is the 
last one in the second row. 
 
4.  You will need to rotate some of the structures to add outer atoms. 
 
5.  Use the same calculation parameters (Molecular Mechanics, MMFF, deselect symmetry) for 
all of these molecules. 
 
6.  Record two unique bond angles for the trigonal bipyramidal molecule. 
 
7.  Rotate each molecule appropriately to obtain a good perspective of these molecular 
geometries. 
 

• Make sure that your notebook entry is complete before going on to the next part of the 
experiment. 

  
VSEPR and Molecular Distortions:  Molecules with Different Coordination and Steric 
Numbers 

Molecules with bonding and nonbonding electrons on their central atoms are susceptible to 
distortions (i.e., non-ideal bond angles).  Let’s investigate some of the features that lead to 
distortions.  Our goal is not only to rationalize why molecules possess distortions, but 
ultimately to estimate distorted bond angles from Lewis structures.    
 
Let’s look at the impact of nonbonding pairs on molecules whose central atoms have a steric 
number of 4.  A classic series includes CH4, NH3, and H2O.  We’ve already examined methane, 
so let’s look at ammonia next! 
 

• Write the “Lewis Structure,”  “Coordination Number,” “Steric Number,” “Shape Name,” 
and “Calculated Bond Angles.”for NH3 in your laboratory notebook. 
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• Since the arrangement of the electron pairs around nitrogen is tetrahedral,, let’s draw NH3 

in Expert mode by selecting a tetrahedral nitrogen and placing it in the workspace.  Add 
the three hydrogen atoms in either Expert or Entry mode. 

 
• The remaining “half-bond” is the tetrahedral environment associated with the nonbonding 

pair in your Lewis structure.  Although we can’t see the lone pair, these electrons impact 
the shape of this molecule.  Delete the “half-bond” by applying the “Delete” button and 
then clicking on the “half-bond”.  Delete the rogue atom that appears after deletion of the 
“half-bond”. 

 
• Save the structure via the File menu. 

 
•  Before conducting the calculation, measure the bond angles and record them (“pre-

calculation angles”) in your laboratory notebook.  Since you employed tetrahedral 
nitrogen during the construction, your angle should be identical to that of methane. 

 
• Setup and conduct the calculation using the familiar parameters (Molecular Mechanics, 

MMFF, deselect symmetry). 
 

• Measure the bond angles and record the calculated values.  In this case, the calculation 
determined that 109.5o isn’t the optimum angle for NH3.  The angles determined by 
MacSpartan Pro reasonably approximate the actual angles of ammonia.   

 
Ammonia, with CN = 3 and SN = 4, has a trigonal pyramidal geometry.  Enlarge/rotate your 
molecule as necessary to view the trigonal pyramidal shape. 
 

• Measure the bond distances using the same menu.  Record these data (in Angstroms) 
appropriately in your notebook.  

 
To investigate the impact of nonbonding pairs further, let’s examine H2O. 
 

• Follow steps analogous to those for NH3.  Calculate and record the bond angle and bond 
distances. 

 
Water, with CN = 2 and SN = 4, has a bent geometry.  Hydrogen atoms occupy two of the 
tetrahedral sites, while the other two sites are associated with the nonbonding pairs.  The atomic 
positions define the molecular shape. 
 

• Discuss the bond angles of CH4, NH3, and H2O in your notebook.  Describe the impact of 
nonbonding pairs relative to electrons in single bonds on the distortion of SN = 4 
molecules.. Hypothesize about the origin of these distortions (i.e., Why does a 
nonbonding pair exert a different influence relative to a pair of bonding electrons?).  
Consider that more acute bond angles correspond to a closer approach of a pair of 
bonding electrons, while VSEPR theory teaches that electron-groups prefer to be as far 
apart as possible about the central atom. 

 
So far we have examined the impact of nonbonding pairs and single bonds on molecular shape.  
What about the impact of a nonbonding pair relative to a double bond?  An instructive pair of 
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molecules for this comparison is formaldehyde (CH2O) and singlet carbene (CH2).  While 
formaldehyde follows the octet rule, carbene does not.  The carbene carbon is electron-deficient 
with six electrons; the carbon has one nonbonding pair.  The central atoms in both of these 
molecules have steric numbers of 3. 
 

• Analyze these molecules (document the Lewis structure and appropriate information in 
your notebook and determine bond angles and distances) using the approach established 
with ammonia and water.  Use “Hartree-Fock”, “3-21G”, and deselect “symmetry” for 
the calculation. 

 
• Discuss these HCH bond angles in your notebook.  Describe the impact of nonbonding 

pairs relative to the electrons of a double bond on the distortion of SN = 3 molecules. .  
Hypothesize about the origin of these distortions, taking into consideration that a double 
bond consists of four electrons while a lone pair consists of only two. 

 
Trigonal Bipyramidal Preferences 

 
The “placement” of the nonbonding pairs was straightforward in the previous examples, since 
each site about the central atom was equivalent.  This is not the case with trigonal bipyramidal 
molecules.  The sites that are 120o apart are called “equatorial,” while the sites that are 90o 
relative to the equatorial sites are called “axial”.  These two types of sites are geometrically 
distinct – they are qualitatively different environments.  Do nonbonding pairs prefer 
equatorial or axial sites in molecules with trigonal bipyramidal electron-group geometries?  
This is a very interesting question!  Let’s find out using MacSpartan Pro!! 
 
The molecule iodine trifluoride, IF3, which has CN = 3 and SN =5, serves as a good example.  
There are three unique relative placements of the nonbonding pairs between the equatorial and 
axial sites of this molecule.  They can be both axial, both equatorial, or one axial and one 
equatorial.  
 

• Draw each of these possible three-dimensional shapes in your notebook.  Sketch the 
molecules to indicate the positions of nonbonding pairs on the trigonal bipyramid as best 
you can.  Label each structure based on the locations of the nonbonding pairs. 

 
• Generate a table in your notebook to clearly communicate the following structural 

features for each possibility.  Consider an ideal structure trigonal bipyramidal structure 
(i.e., no distortions) for these determinations. 

 
1. Number of 90o angles between nonbonding pairs.  (Note:  This angle cannot be 

experimentally measured since electron positions cannot be located with high 
precision.  However, this “angle” is useful in rationalizing trigonal bipyramidal 
preferences.) 

2. Number of 90o angles between nonbonding pairs and bonding pairs.  (Note:  
This angle is also impossible to measure experimentally.) 

   
Hint:  The “axial/axial” structure features six 90o angles between nonbonding and bonding pairs.  
Feel free to ask for help to verify your approach to counting these angles. 
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Based on what you have learned already during this experiment, can you speculate on which 
structure might be the “best” (i.e., the lowest energy of IF3)?  Rank the structures from “best” 
to “worst” and briefly provide your rationale.  It is important for chemists to try to anticipate 
the outcome of computer calculations, and not accept the computed results blindly.  Computer 
calculations don’t rely on “chemical intuition,” so hypotheses held by the experimentalist can 
help rule out unreasonable outcomes.  Don’t worry.  Points won’t be deducted for your selection 
of “best” and “worst,” but only for the clarity of your discussion/rationale. 
 
Let’s find out which structure MacSpartan thinks is the lowest energy geometry for IF3.  Nature 
defaults to the lowest energy state available, so the geometry with the lowest energy best 
represents the naturally occurring structure. 
 
MacSpartan Pro can calculate the approximate energies of molecules.  Indeed, the calculation of 
these energies is one of the primary applications of computational chemistry software.  In this 
study, the relative energies of the three possible structures are of more interest than their 
absolute energies. 
 

• Draw one of the structures by starting with a trigonal bipyramidal iodine fragment in the 
Expert mode.  Add the fluorine atoms into the appropriate equatorial or axial locations 
via either Entry or Expert mode.  Delete the remaining “half-bonds” (and resulting 
extraneous atoms) to indicate the locations of the nonbonding electrons. 

 
In this case, a calculation of “Equilibrium Geometry” isn’t appropriate.  Our objective is to 
determine the energy of each structural possibility for comparison purposes.  A calculation of 
“Equilibrium Geometry” starting with any of these three possibilities should (if the proper level 
of theory (calculation method) is applied) provide the naturally occurring structure, along with 
any distortions in the actual molcule.  The appropriate calculation here is called “Single Point 
Energy.”  A Single Point Energy calculation simply provides the energy associated with the 
submitted structure.  The shape of the molecule won’t change during the calculation, in contrast 
to previous calculations.  In this way, a “Single Point Energy” calculation doesn’t provide 
information about distorted angles.  However, it will permit a ranking of our three possibilities in 
terms of energy. 
 

• Conduct a calculation (Single Point Energy, Semi-Empirical, AM1, deselect 
symmetry) on your structure. 

 
• Record its energy (provided in kcal/mol at the bottom of the workspace) next to the 

corresponding structure in your notebook. 
 

• Repeat these steps for the remaining two structures. 
 

• Which structure best represents naturally occurring IF3?  Was your prediction correct?  
Based on your ranking of possible structures, discuss the “rules” that govern 
trigonal bipyramidal preferences (What feature is very “destabilizing” for a CN = 3, 
SN = 5  molecule?  What distinguishes the best structure from the second best 
possibility?  Be specific.). 
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• Starting with the best structure of IF3 (redraw in a new window), calculate the distorted 
angle in this molecule.  For this calculation, use “Equilibrium Geometry”, “Semi-
Empirical”, “AM1” and deselect “symmetry”.  This geometry is called “T-shaped”. 

 
Other Factors that Influence Molecular Shapes 

 
Based on your experience thus far, what would you predict for the bond angle of hydrogen 
sulfide, H2S?  Since sulfur is in the same column as oxygen, the Lewis structure for H2S is very 
similar to that of H2O.  Both of these molecules have CN = 2 and SN = 4 and possess bent 
geometries. 
 
What do you expect for the bond angle of H2S?  109.5o?  104.5o?  More acute than 104.5o?  More 
obtuse than 104.5o?  We know from our discussion of periodic trends that oxygen and sulfur 
possess different properties.  For example, these atoms have different atomic radii.  How might 
the exchange of oxygen for sulfur impact the bond angle?  This question is too subtle for  
VSEPR theory.  These issues are explored in more depth in CHEM 411 (Advanced Inorganic 
Chemistry).  For now, let’s apply MacSpartan Pro to gain some insight. 
 

• Follow the same steps as for NH3 above.  Calculate the bond angle and bond distances 
of H2S. 

 
Are you surprised by the calculated bond angle of H2S?  Discuss the structural differences 
between H2O (calculated earlier) and H2S.  Speculate on why one of these molecules has a more 
acute bond angle (i.e., Why do the nonbonding pairs of one molecule exert more influence than 
they do in the other?  Be specific.) 
 



Experiment 4 

 9

Hand-Held Models, Bond Angle Predictions, and MacSpartan Pro: 
 
Although the inspection of molecular shapes on the computer screen is instructive, it is also 
useful to hold a representation of a molecule in your hand.  Molecular model kits are valuable 
tools to essentially all chemists.  The Molecular Visions® model kit is used extensively by 
Macalester students in Organic Chemistry (CHEM 211-212).  
 
The labels on the components of this model kit feature terminology (sp-3, sp-2, etc.) that will be 
discussed in class very soon.  For now, use this information to guide your selection of 
appropriate pieces. 
 

Description of Model Kit 
Piece 

Element Geometry 

Black, SP-3 Carbon Tetrahedral 
Red, SP-3 Oxygen  Tetrahedral 
Blue, SP-3 Nitrogen  Tetrahedral 
Light Green, SP-3 Fluorine Tetrahedral 
Pink, SP-3 Chlorine Tetrahedral 
Grey, SP-2 Carbon, Nitrogen or oxygen Trigonal Planar 
Grey, rectangle Carbon-Carbon Double Bond  
Grey, U-shaped Two of these can be assembled to create a carbon-carbon 

double bond. 
Red, U-shaped Two of these can be assembled to create an oxygen-oxygen 

double bond. 
Note that red and grey u-shaped pieces are assembled to best 
indicate a carbon (or nitrogen) to oxygen double bond. 

Pink, T-shaped Two of these can be assembled to create an octahedral electron-
group geometry. 

Grey, Triangle and Grey, 
Straight 

These two pieces can be assembled to create a trigonal 
bipyramidal electron-group geometry. 

White Ball Hydrogen atom 
 

• Construct a molecular model of acetone, C3H6O. You will need to obtain the relevant 
parts from the drawers of the rolling cart.  The oxygen atom in acetone is connected to a 
single carbon atom, with no hydrogen atoms connected to this same carbon atom.  
Acetone is the primary component of fingernail polish remover.  Feel free to ask your lab 
instructor or assistant for help. 

 
• Use your model to hypothesize all bond angles for acetone. Label a Lewis structure of 

C3H6O with your hypothesized angles.  Ask your lab assistant or instructor to inspect 
your hand-held model before disassembly.  Your lab assistant/instructor will initial your 
Lewis Structure if all aspects of your model are correct.    

 
• Select Molecular Mechanics, MMFF and deselect symmetry for your MacSpartan Pro 

acetone calculation.  Determine all calculated angles and record these appropriately on a 
Lewis structure in your laboratory notebook. 
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• Discuss the agreement between your hypothesized and the calculated angles.  [Note:  The 
accuracy of calculated angles depends on the calculation method employed.  It is possible 
that Molecular Mechanics/MMFF isn’t the optimum calculation approach for acetone.] 

 
• Rationalize the deviations from ideal angles in acetone. 

 
• Repeat the same procedure [construct hand-held model, show your lab 

instructor/assistant, hypothesize angles, calculate angles using MacSpartan Pro 
(Molecular Mechanics, MMFF, deselect symmetry), discuss the agreement between the 
hypothesized and calculated angles, and rationalize deviations] for the following 
molecules: 

 
Ethylene, C2H4 
Diethylamine, NH(CH2CH3)2  Set “Start from:” to MMFF Conformer for diethylamine. 
Ethanol, C2H6O [This molecule features an – OH group.]  Again, you will 

want to set “Start from:” to MMFF conformer for ethanol 
Nitrate anion, NO3

- [Include reasonable resonance forms with formal charges.  
Draw one of these resonance forms in Expert mode.  
Indicate “Anion” (-1) as the Total Charge in the 
Setup:Calculations menu.]  Set “Start from:” back to Initial 
Geometry. 

 
 
 
Return each of your MolecularVisions® model kit components to the drawer it came from 

when you have finished the experiment 
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Name________________________________ 

 
Chemistry 112 Laboratory 

Experiment 4:  An Exploration of Molecular Shapes:   
MacSpartan Pro and Molecular Models 

 
Advance Study Assignment 

 
Read through the experiment carefully and then provide a 1-2 sentence synopsis of the objectives 
of the experiment in the box below. 

 
 
Please provide the answers to the following questions on this page. Bring it with you, completed, 
when you come to lab. 
 

1. Knowledge of periodic trends is important to understand the subtler aspects of VSEPR 
theory.  Explain fundamentally why a sulfur atom is larger than an oxygen atom. 

 
 
 
 
 
 
 
 
 
 
 

2. Rank the following isoelectronic species in order of increasing (a) size, (b) ionization 
energy, and (c) electron affinity. 

 
Cl-, K+, Ca2+ 
 

 


